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Тема: Основи растрової графіки. Робота з Adobe Photoshop 

Навчальна мета: Познайомитися з растровою графікою та її  складовими, дізнатися про 

програми для роботи з графікою такі, як Аdobe Photoshop 

Розвивальна мета: Розвивати зорову пам’ять, вміння працювати з програмами та 

узагальнювати набуті знання 

Виховна мета: Виховувати зосередженість, вміння активно сприймати новий матеріал. 

Тип уроку:  Урок вивчення нового матеріалу 
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Хід уроку 

І. Організаційний момент 

Доброго ранку, діти!  

Черговий, хто сьогодні відсутній в класі? Як ви впоралися з домашнім завданням? 

Сьогодні ми з вами розглянемо тему: «Комп’ютерна графіка. Види графіки. Основи растрової 

та векторної графіки. Робота з Adobe Photoshop, Macromedia Flash.». 

II. Етап орієнтації 

Хто мені назве мету сьогоднішнього уроку? ….(обговорення) Правильно 

Мета сьогоднішнього уроку якомога найкраще познайомитися з поняттям комп’ютерної 

графіки, програмами для роботи з графікою. 

III. Етап проектування 

План уроку 

1. Актуалізація опорного матеріалу 

2. Основи растрової графіки. 

3. Робота з Adobe Photoshop 

ІV. Етап навчальної діяльності 

Актуалізація опорного матеріалу 

Основи растрової графіки. 

Растрове зображення – зображення, створене безліччю близько розташованих точок 

різного кольору (пікселів). 

Для відтворення зображення на пристрої виведення (моніторі, принтері тощо) зображення 

розбивається на точки — пікселі. Наочним прикладом цього є формування зображення на 

екрані монітора.  

Подання зображення у формі набору пікселів, упорядкованих за рядками і стовпчикам 

називається растром.  

Будь-яке зображення, побудоване на основі растра, називають растровим. 

Застосовується у випадках, коли графічне зображення має багато напівтонів і інформація про 

колір важливіша за інформацію про форму (наприклад, фотографії).  

При редагуванні растрових об'єктів, користувач змінює колір точок, а не форми ліній.  

Важливою характеристикою растра є його роздільна здатність, тобто кількість пікселів на 

одиницю довжини. Значення роздільної здатності звичайно записується в одиницях dpi (від 

англ. «dots per inch» — точок на дюйм). Роздільна здатність екранного зображення звичайно 

становить 72 або 96 dpi, відбитка лазерного принтера — 600 dpi. 



3 кожним пікселем пов'язані числові значення, що визначають його колір. 

Роздільність вказує кількість точок на одиницю довжини.  

Потрібно розрізняти:  

• роздільність оригінала;  

• роздільність екранного зображення;  

• роздільність друкованого зображення.  

Роздільність оригінала. Вимірюється у точках на дюйм (dpi) і залежить від вимог до якості 

зображення та розміру файлу, способу оцифрування або методу створення готового 

зображення, вибраного формату файлу та інших параметрів. Зрештою, чим вище вимоги до 

якості, тим більша має бути роздільність.  

Роздільність екранного зображення. Для екранного зображення, найменшу точку растра 

називають пікселом. Розмір піксела коливається в залежності від вибраної роздільності екрана 

монітора, роздільності оригіналу й масштабу відображення. Монітори можуть забезпечити 

роздільність 640х480, 800х600, 1024х768, 1600х1200 і вище. Для екранного зображення 

достатньо роздільності 72 dpi.  

Роздільність друкованого зображення. Розмір точки растрового зображення залежить від 

застосованого методу та параметрів растрування оригіналу. При раструванні на оригінал 

накладається сітка ліній, комірки якої утворюють елемент растра. Розмір точки растра 

розраховується для кожного елементу і залежить від інтенсивності тону в цій комірці. Розмір 

файлу. Засобами растрової графіки створюють та обробляють зображення, що потребують 

високої точності у передачі кольорів та напівтонів. Розміри файлів напряму зв'язані зі 

збільшенням роздільності і можуть сягати десятки мегабайтів. 

Масштабування растрових зображень. При збільшенні растрового зображення, можна 

спостерігати пікселізацію, тобто при масштабуванні збільшується розмір точок і стають 

помітними елементи растра.  

Прикладні програми растрової графіки призначені для створення книжкових та журнальних 

ілюстрацій, обробки оцифрованих фотографій, слайдів, відеокадрів, кадрів мультиплікаційних 

фільмів.  

Програми растрової графіки можуть використовувати:  

• художники-ілюстратори;  

• мультиплікатори;  

• дизайнери;  

• фотографи;  

• поліграфісти;  

• web-дизайнери;  

• вільні художники, із масою творчих ідей та потенціалу.  

Але растрова графіка має свої переваги і недоліки. 

Переваги:  

простота автоматизованого вводу (оцифрування) зображень, фотографій, слайдів, рисунків за 

допомогою сканерів, відеокамер, цифрових фотоапаратів; фотореалістичність. Можна 

отримувати різні ефекти, такі як туман, розмитість, тонко регулювати кольори, створювати 

глибину предметів. 

Недоліки:  

Складність управління окремими фрагментами зображення. Потрібно самостійно виділяти 

ділянку, що є складним процесом. Растрове зображення має певну роздільність і глибину 

представлення кольорів. Ці параметри можна змінювати лише у визначених межах і, як 



правило, із втратою якості. Розмір файлу є пропорційним до площі зображення, роздільності і 

типу зображення, і, переважно, при хорошій якості є великим. 

Робота з Adobe Photoshop 

Графічні редактори – це програми для роботи з графічними об’єктами. 

 

Найпопулярнішими програмами для растрової графіки є:  

• Adobe PhotoShop,  

• Corel PhotoPaint,  

• Macromedia FireWorks,  

• Fractal Design Painter,  

•  Paint.  

Безсумнівним лідером серед таких пакетів звісно є Adobe Photoshop визнаний як 

професіоналами, так і аматорами, який надає дизайнерам та іншім фахівцям у галузі 

комп’ютерної графіки фантастичні можливості.  

Найпопулярнішими програмами для векторної графіки є: 

• Corel Draw,  

• Adobe Illustrator,  

• Macromedia Flash,  

• Word Editor. 

 

CorelDraw — це потужний і універсальний пакет, що містить повний набір 

різноманітних програм й додатків. Але суспільство професійних дизайнерів досить 

довго практично ігнорувало цю потужну й постійно оновлювану програму.  

Adobe Illustrator є «професійним» побратимом Draw. Забезпечуючи максимальну 

сумісність з Draw 8, у цьому пакеті, починаючи з 7-ї версії, реалізовані всі основні 

функції роботи з векторними об’єктами. 

 

Програма растрової графіки Adobe Photoshop (надалі — Photoshop) 

призначена для розробки растрових графічних документів з метою їх 

тиражування у вигляді друкарської продукції, а також для електронної 

публікації як графічні Web-сторінки або їх складові частини. 

 

Робота з Adobe Photoshop 

 
Мал. 1 Строка меню 

 

 File (Файл) — цим меню доводиться користуватися в основному на початку і кінці 

роботи, оскільки більшість його функцій пов'язані із створенням відкриттям і 

збереженням файлів. Краще відразу навчитися користуватися клавіатурними 

скороченнями для запуску цих команд — ви зможете заощадити багато часу;  

 Edit (Редактироование) — в цьому меню знаходяться основні команди редагування, 

багато з яких є і в інших програмах: Undo (Отменить), Paste (Вставити), Сору 

(Копіювати) і т. д.; 

 Image (Изображение) — меню, створене для роботи безпосередньо із зображенням. 

Багато його команд доведеться застосовувати майже в кожній роботі. 

 Layer (Слой) — робота з шарами; 

 Select (Выделение) — створення і редагування виділення; 



 Filter (Фильтр) — в цьому меню знаходяться фільтри — додаткові модулі Photoshop, що 

виконують самі різні функції; 

 View (Вид) — різні настройки інтерфейсу, які допомагають  користувачеві в роботі; 

 Window (Окно) — за допомогою цього меню ви управляєте відображенням палітр і 

розміщенням документів на екрані; 

Про Help (Помощь) — команди довідкової системи  

Панель інструментів  

Панель параметрів розташована під рядком меню. Призначена для настройки параметрів 

вибраного інструменту. 

 
Мал. 1.1. Вікно програми Photoshop CS: 

1 — системні меню програми і документа; 2 — заголовки програми і документа; 3 — 

рядок меню; 4 — панель параметрів; 5 — системні кнопки документа; 6 — кнопка розкриття 

вікна File Browser; 7 — область стиковки палітр; 8 — системні кнопки програми; 9 — блок 

інструментів; 10 — робоча область вікна програми; 11 — рядок стану програми; 12 — палітри. 

 

Для того щоб активізувати інструмент, піктограма якого в даний момент видно на екрані, 

клацніть по ній. Поруч із деякими піктограмами розташована маленька стрілка. Якщо по ній 

клацнути, розкриється спливаюча палітра, де можна вибрати інструмент, що входить у ту ж 

групу.  

Ще зручніше викликати інструменти за допомогою клавіатури (запам'ятайте літери, вказані на 

наступних сторінках для кожного інструменту). Якщо ви забули клавішну комбінацію, наведіть 

курсор на піктограму інструменту, затримайте на кілька секунд, і спливаюча підказка нагадає її 

вам (рис. 1.1). Щоб поперемінно викликати що входять у яку-небудь групу інструменти, 

піктограми яких заховані, натисніть клавішу Shift і відповідну "гарячу" клавішу. Також можна, 

натиснувши клавішу Alt, клацнути по піктограмі видимого інструменту.  

Для кожного інструменту задаються свої власні параметри (наприклад, режим змішування, 

значення непрозорості) на панелі опцій, розташованої вгорі екрану (детальніше про панель 

опцій розказано в розділі «Панель опцій» цього розділу) - див. рис. 1.2. Склад параметрів на 

панелі опцій змінюється в залежності від того, який інструмент вибраний. 

 



На панелі опцій з правого боку розташована піктограма активного інструменту. 

Якщо клацнути по стрілочки поряд з піктограмою, розкриється меню, що випадає, 

де ви можете вибрати інший інструмент. Цей список можна редагувати, видаляти 

рідко використовуються і додавати часто застосовуються інструменти. Установка 

на панелі опцій зберігаються для кожного інструменту, якщо їх не змінити або не 

відновити прийняті за замовчуванням. Завантажити зараз, додати і зберегти різні 

комбінації кнопок, а також відновити прийняті за замовчуванням характеристики 

інструменту можна за допомогою команд меню випадаючому панелі (мал. 1.3). Для того, щоб 

відновити прийняті за замовчуванням значення опцій для всіх інструментів, там же виберіть 

команду Reset All Tools (Відновити всі інструменти) або клацніть по кнопці Reset All Tools у 

вікні Edit> Preferences> General (Правка> Установки> Загальні). 

 

Використання інструментів малювання, виділення, переміщення та копіювання 

фрагментів. 

 

 

 

 

 
 

 

 
Рис. 1.4. Інструменти виділення 

 

 

 

 

 

 

 

 

 

 
Рис 1.5. Інструменти малювання 

 

  
 Рис 1.6. Інструменти копіювання та переміщення фрагментів 



 
Рис 1.7. Вигляд екрану програми 

 

Клацанням по кнопці (1) викликається меню керування додатком. Воно містить наступні 

команди: Restore (Відновити), Move (Перемістити), Size (Розмір), Minimize (Згорнути), 

Maximize (Розгорнути) і Close (Закрити). За допомогою кнопки (7) викликається меню 

керування документом. В основному меню документа містяться такі команди, як Restore 

(Відновити), Move (Перемістити), Size (Розмір), Minimize (Згорнути), Maximize (Розгорнути), 

Close (Закрити) і Next (Наступний).  

Клацніть мишею по будь-якого елементу панелі меню (2), щоб отримати доступ до різних 

діалогових вікон, підменю та командам.  

Для визначення параметрів обраного інструменту призначена панель опцій (3).  

Натисніть кнопку Minimize (4), щоб згорнути вікно додатка; в результаті його піктограма буде 

розташована на панелі завдань. Для того, щоб відновити колишній розмір вікна, просто 

клацніть по цьому значку.  

Кнопка Maximize (Розгорнути) додатки (5) або документа (10) дозволяє збільшити розмір вікна, 

наскільки це можливо. Якщо ж хочете відновити колишній розмір вікна, натисніть на кнопку 

Restore. Після того як розмір вікна відновиться, кнопка Restore перетвориться на кнопку 

Maximize.  

Кнопка закриття програми (6) закриває вікно програми.  

Заголовок (8) містить найменування і масштаб зображення, ім'я поточного шару або 



ідентифікатор Background (Фон) та інформацію про режим зображення.  

Згорнути документ можна, натиснувши кнопку Minimize (9) документа, при цьому піктограма 

документа буде розташована в лівому нижньому куті вікна програми. Натисніть кнопку Restore 

(Відновити) (16), і буде відновлений колишній розмір вікна документа.  

Якщо хочете закрити зображення або палітру, клацніть по піктограмі (11).  

Щоб відобразити на екрані лінійки (12), скористайтеся командою View> Show Rulers (Вигляд> 

Показати лінійки). Положення курсора вказується відповідним маркером на кожній з лінійок. 

Виберіть одиницю вимірювання для лінійки в діалоговому вікні Edit> Preferences> Units & 

Rulers (Правка> Установки> Одиниці виміру і лінійки).  

У програмі є 13 палітр (13), які можна переміщати по екрану і міняти їх угруповання, що 

приймається за замовчуванням. Клацніть по вкладці (імені палітри) у групі палітр, і вона стане 

найбільш верхньою в даному стеку.  

Для того, щоб показати / сховати панель інструментів (14) і всі відкриті палітри, натисніть 

клавішу Tab.  

У рядку стану (15) відображаються значення наступних параметрів: Document Size (Розмір 

документа), Document Profile (Профіль документа), Scratch Sizes (Об'єм пам'яті) - обсяг 

оперативної пам'яті, в даний момент доступний для програми Photoshop, Efficiency 

(Ефективність) - частка використовуваної оперативної пам'яті, Timing (Час) і Current Tool 

(Поточний інструмент)-ім'я інструменту. Вказавши курсором на рядок стану, натисніть і 

утримуйте кнопку миші, щоб побачити, як буде розташоване зображення на сторінці. Якщо, 

вказавши курсором на рядок стану, натиснути кнопку миші, утримуючи клавішу Alt, то на 

екран буде виведена інформація про розміри зображення, кількість каналів, режим і дозволі. 

Щоб почати відлік часу з нуля, виберіть елемент меню Timing (Час). 

 

Створення текстових написів. 

  

 
Рис. 1.8. Інструменти тексту 

 

Багатошарові зображення. 

Шар, в даний момент виділений на палітрі Layers (Шари), - єдиний, який можна редагувати. У 

зображення може бути або тільки фон (ніяких шарів), або кілька шарів  

У шари можуть включатися ефекти, порядок слідування шарів можна міняти, шари можна 

переміщати; вони прозорі там, де немає зображення, що дозволяє бачити крізь цілу стопку 

шарів. Одна з переваг використання шарів - можливість розподіляти компоненти зображення по 

окремим верствам і редагувати їх, не зачіпаючи інші шари. 

Фільтри Назва групи Призначення 

Texture  Текстура  Додають в зображення основу текстури  

Artistic  Художні  Використовуються для додання зображенню 

природнішого, тобто менш «комп'ютерного» вигляду  

Pixelate  Пікселізация  Надають зображенням вигляду живописних або 



мальованих оригіналів, виконаних різними 

інструментами. Деякі фільтри додають в зображення 

зернистість, шум, краєві деталі або елементи текстур 

для імітації манери художників-пуантилістів  

Distort  Деформація  Виконують геометричне спотворення зображень і 

використовуються для створення тривимірних і інших 

пластичних ефектів  

Noise  Шум  Додають або видаляють пікселі з випадковими 

колірними значеннями і особливим чином 

пом'якшують зображення у виділеній області. Ви 

можете використовувати фільтри групи Шум (Noise) 

для виправлення таких дефектів зображення, як пил і 

подряпини, створювати незвичайні малюнки текстур, 

які потім можуть бути використані, наприклад, як фон 

для текстових елементів  

Blur  Розмиття  Перетворять виділену область в різні види нерізкого 

размиття для додання, наприклад, ілюзії руху  

 

VI. Контрольно-оцінювальний етап 

Запитання до учнів 

Вчитель оцінює роботу учнів на уроці.  

VII.Домашнє завдання 

Вивчити терміни 

§ 27 

 

 


